
Application Control 
Manager Guide

PV630 SV201



Copyright © 2022 OneStream Software LLC. All rights reserved.

Any warranty with respect to the software or its functionality will be expressly given in the 
Subscription License Agreement or Software License and Services Agreement between 
OneStream and the warrantee. This document does not itself constitute a representation or 
warranty with respect to the software or any related matter.

OneStream Software, OneStream, Extensible Dimensionality and the OneStream logo are 
trademarks of OneStream Software LLC in the United States and other countries. Microsoft, 
Microsoft Azure, Microsoft Office, Windows, Windows Server, Excel, .NET Framework, Internet 
Information Services, Windows Communication Foundation and SQL Server are registered 
trademarks or trademarks of Microsoft Corporation in the United States and/or other countries. 
DevExpress is a registered trademark of Developer Express, Inc. Cisco is a registered trademark 
of Cisco Systems, Inc. Intel is a trademark of Intel Corporation. AMD64 is a trademark of 
Advanced Micro Devices, Inc. Other names may be trademarks of their respective owners.



Table of Contents
Solution Overview 1

Setup and Installation 2

Dependencies 2

Select the Application Control Manager Development Location 2

Create the OneStream Development Application 3

Application Server Settings 3

Configure the OneStream Application Server 3

Install Application Control Manager 4

Set Up Application Control Manager 5

Create Tables 5

Package Contents 5

Installing ImportAddOn 6

Application Control Manager Dashboard 9

Home 9

Home Toolbar 10

Request Filter Bar 10

Request Detail 11

Manage Request 11

Request Summary and Workflow Buttons 12

Application Control Manager Guide i

Table of Contents



Request Buttons 12

Item Table and Documents 13

Item Detail and Item Buttons 14

Request Activity 14

Reports 15

Export Report Data 15

Create Custom Reports 16

Add Reports to the Application Control Manager Custom 
Dashboard 18

Creating a Grid View Component 20

Complete the Configuration 23

Administration 24

Metadata 25

Retain Source System Order 27

Security 28

Properties 29

Varying Properties 31

Non-varying Properties 32

Validations 34

Views 35

Flows 40

Application Control Manager Guide ii

Table of Contents



Reports (Administrator) 45

Exports 47

Logs 48

Settings 49

Global Setup 49

Load/Extract 52

Uninstall 53

Administration Tasks 54

Create a New Flow 54

Refreshing Dynamic View Dashboards 54

Metadata Import 55

Setup Data Sources 55

Workflow Profiles 57

Global POV Time 58

Metadata Import Fields 59

Data Management Groups 62

Metadata Synchronization 64

Initial Setup and Configuration 64

Data Management Job Configuration 67

Execution 68

Application Control Manager Guide iii

Table of Contents



Request Migration 68

Initial Setup and Configuration 68

Help & Miscellaneous Information 71

Display Settings 71

Package Contents & Naming Conventions 71

Solution Database Migration Advice 72

MarketPlace Solution Modification Considerations 72

Application Control Manager Guide iv

Table of Contents



Solution Overview
OneStream Application Control Manager is a MarketPlace solution designed to support and 
manage user change requests and ensure the right level of control and governance over 
application changes.

With Application Control Manager, you can:

 l Read and detect metadata changes in GL/ERP, data warehouses, and MDM tools and 
synchronize changes to OneStream.

 l Provide an easy way for users to request changes to OneStream applications. For 
example, new or updated accounts, cost centers, other dimensions and user privileges.

 l Utilize multi-level approval workflow for change requests.

 l Create audit reports on application change requests.

 l Manage metadata changes across environments (Dev-Test-Prod).

 l Export metadata changes back to source systems.
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Setup and Installation
This section contains important details related to the planning, configuring, and installation of your 
solution. Before you install the solution, familiarize yourself with these details.

Dependencies
Component Description

OneStream 6.3.0 
or later

Minimum OneStream Platform version required to install this version of 
Application Control Manager.

Microsoft SQL 
Server

2016 Standard 
SP1 or later

Application Control Manager requires an instance of Microsoft SQL 
Server 2016 Standard SP1 or later.

Select the Application Control Manager 
Development Location
Before beginning installation, decide whether to build the solution directly in the Production 
OneStream application or in a separate Development OneStream application. This section 
provides some key considerations for each option.

Production OneStream Application: The primary advantage of building the solution in a 
Production application is that you will not have to migrate the resulting work from a Development 
application. However, there are intrinsic risks when making design changes to an application used 
in a Production capacity and not advised.

NOTE: OneStream strongly recommends that you implement the solution in the 
Development environment with a fresh copy of the Production application before 
starting work.

Development OneStream Application: As a best practice, use the Development OneStream 
application to build the solution.
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Create the OneStream Development 
Application

 1. Ensure all the OneStream artifacts relating to Application Control Manager such as 
Workflow Profiles and Entities are in the Production application.

 2. Copy your Production OneStream application to your Development environment and 
rename it. This Development version will be used for your Application Control Manager 
project.

Application Server Settings
You may need to edit the OneStream Application Server Configuration so users can create and 
change data in the additional database tables. If other MarketPlace solutions (such as Specialty 
Planning) are already in the application, these adjustments may already exist.

Configure the OneStream Application Server
Be sure that the security group settings include the users who work on and set up the solution 
before proceeding.

NOTE: Group settings are applicable to all MarketPlace solutions; it is important to 
keep the group names generic.

 1. Start the OneStream Server Configuration Utility as an Administrator.

 2. Click Open Application Server Configuration File > Database.

 3. Edit the following OneStream Database Server properties:

 l Access Group for Ancillary Tables: Select a group that includes those who will access 
records.

 l Can Create Ancillary Tables: True

 l Can Edit Ancillary Table Data: True

 l Maintenance Group for Ancillary Tables: Select a group to edit and maintain tables.
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 l Table Creation Group for Ancillary Tables: Select a group who can create tables.

 4. Restart Internet Information Server.

Install Application Control Manager
 1. On the OneStream MarketPlace Dashboard, click MarketPlace > Application Control 

Manager.

 2. On the Application Control Manager Solution page, select the appropriate OneStream 
platform version from the Minimum Platform Version drop-down list.

 3. Select the most recent version from the Solution Version drop-down list and then click 
Download.

 4. Log in to OneStream.

 5. On the Application tab, click Tools > Load/Extract.

 6. On the Load tab, locate the solution package using the Select File icon and click Open.

 7. When the solution’s file name appears, click Load.

 8. Click Close to complete the installation.
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Set Up Application Control Manager
The first time you run Application Control Manager, you are guided through the table setup 
process.

In OneStream, click OnePlace > Dashboards > Application Control Manager > Application 
Control Manager.

Create Tables
 1. Click Step 1: Setup Tables

This step may be necessary when upgrading even if tables are already present. Application 
Control Manager will not drop any tables that already exist but will modify table structures 
and add any new ones if necessary.

 2. When setup is complete, click Step 2: Launch Solution to open Application Control 
Manager.

Package Contents
The Application Control Manager is the user interface for settings and application governance. 
The following Business Rules are included:

 l ACM_ImportMetadata

 l ACM_MetadataSource

 l ACM_DataSet

 l ACM_Reports

 l ACM_Engine
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 l ACM_Validations

 l ACM_Param

 l ACM_CreateFlowViews

 l ACM_CreateRequest

 l ACM_MetadataCommit

 l ACM_MetadataImport

 l ACM_PrepareMetadata

The following Business Rules are included with the ImportAddOn file. Refer to Installing 
ImportAddOn for more information.

 l ACM_AccountSource

 l ACM_EntitySource

 l ACM_UD1-8Source

Data Management Sequences and Steps are created for use with their related Business Rules. 
The benefit of running these processes through a Data Management Sequence is that they can 
run in the background while the user continues their work.

Installing ImportAddOn
When you first install Application Control Manager, the solution is a clean install and all flows need 
to be created individually. To use the base flows and default configuration, you need to install the 
setup and seed files. The ImportAddOn_ACMS file is a file that must be installed separately. This 
file installs the default flows for setting up a flow or using a source import, and prevents deleting 
any customized flows when upgrading to new versions of Application Control Manager.

NOTE: It is not recommended to modify any standard default flows provide with 
installation.

 1. Install Application Control Manager from MarketPlace.

 2. Install the ImportAddOn_ACMS file located here: Application > Dashboards > 
Application Control Manager > Files > ImportAddOn_ACM.zip.
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 3. Download the ImportAddOn_ACM.zip file.

 4. Extract the following files from ImportAddOn_ACM.zip:

 l AddOn.zip

 l ImportAddOnTableSeed_ACMS.txt

 5. NOTE: The AddOn.zip file must be uploaded before 
ImportAddOnTableSeed_ACMS because tables must be set up to process 
ImportAddOnTableSeed_ACMS data.

 6. Click Application >  Load/Extract.

 a. Load the extracted AddOn.zip file. The following items are added to Application 
Control Manager:

 i. ACM MetadataImport Data Management Group

 ii. Parser Business Rules:

 l ACM_AccountSource Business Rule

 l ACM_EntitySource Business Rule

 l ACM_UD1-8Source Business Rule

 iii. Transformation Rules:

 l ACM_ImportMetadata_View

 l ACM_ImportMetadata_Account

 l ACM_ImportMetadata_Entity

 iv. Transformation Rule Profile:

 l ACM_ImportMetadata

 7. Navigate to Application Control Manager > Global Settings > Load/Extract.

 8. In the Load tab, select ImportAddOnTableSeed_ACMS.txt, and then click Load . A 
completion message is displayed.
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After installation, all base functionality such as Validations, Metadata, Flows, and Views can be 
used.

NOTE: This optional add-on file does not need to be installed but all set up will have 
to be done manually from start to finish. If you do an Uninstall Full and then need 
to reinstall Application Control Manager, you will need to reinstall ImportAddOn_
ACMS.
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Application Control Manager 
Dashboard
In the Application Control Manager dashboard, use the toolbar buttons to navigate to different 
pages.

 l Home: Create, edit, manage, claim, push back, reject, and commit requests

 l Reports: Run reports on requests

 l Administration (Admin Only): Define and create request views, flows, dimensions, 
properties, and validations

 l Settings (Admin Only): Global settings for the solution. Most settings are configured once 
during the initial install and don’t need to be updated on an ongoing basis.

 l Help: View the documentation

Home
The Home page is the entry point for the solution.
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Home Toolbar

 l Create: Create a new request

 l Edit: Update an existing request

 l Manage: Redirect to Manage Request to add/update items

 l View: View an existing request in read-only mode. Request Workflow and Save buttons are 
not displayed so the request cannot be edited.

 l Claim: Claims the request so the current user can work on it. Removes this request from 
the queue of other users.

 l Unclaim: Puts the request back into the queue as Unclaimed for other users to claim.

 l Regress: Pushes the request back to a prior step. (Admin Only)

 l Reject: Rejects and close the request.

 l Remove: Sets the status of the selected request to Closed

 l Commit: Manually launches the Commit Data Management sequence to commit all 
requests currently at the Commit step with a status of Waiting.

Request Filter Bar

 l My Requests: Shows requests the current user has created

 l My Actions: Shows requests where the current user has an action to take
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 l My Queue: Shows requests where the current user is in the group that has the next action 
to take (for example, Enrich group)

 l Active Requests: Shows requests that are currently active, not in a closed, completed or 
committed status

 l All Recent: Shows all requests in any state from the last XX days as configured in the next 
option

 l
: Configures how many days to view in the All Recent filter.

Request Detail

 l Items Table: Shows summary information of the items created on the selected request

 l Documents: View documents attached to the selected request

 l Request Activity: View the activity log for the selected request and add comments to it

Manage Request
On the Manage Request page, you can:
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 l Move a request forward or backward in the request flow.

 l Reject a request.

 l Validate items in a request.

 l Create or delete request items.

 l Attach, delete, and download documents.

Request Summary and Workflow Buttons

 l Request Summary

 o Request ID, Type, Current Step and Reason

 l Request Workflow Buttons

 o Unclaim: Puts the request back into the queue as Unclaimed for other approved 
users to claim and redirects back to the Application Control Manager Home page.

 o Remove: Rejects and closes the current request. You can no longer edit the request 
after this action.

 o Revert: Pushes the request back to the previous step in the request flow.

 o Validate: Checks the validation status of all items in the current request.

 o Advance: Moves the request to the next step in the request flow.

 o Home: Redirects to the Application Control Manager Home page.

Request Buttons
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 l Add: Opens a dialog box to create a new item.

 l Remove: Deletes the selected item.

 l Attach: Opens file explorer to attach a supporting document.

 l Delete: Deletes the selected document.

 l View: Downloads the selected document.

Item Table and Documents

 l Item Group: For Grouped Request Types (such as Cost Center), shows the Item Name of 
the Group Parent Item.

 l SubItem: True/False, indicates if the item is a sub item of a Grouped Item. Only valid on 
Grouped Request Types.

 l Action: The metadata action to be performed at the Commit step.

 l Dimension: OneStream dimension to be updated at the Commit step.

 l Parent Name: OneStream parent member name.

 l Member Name: OneStream member name.

 l Description: OneStream description.

 l Notes: An input text field that is specific to the particular item.

 l Validated: True/False, indicates if all item properties are valid.

 l Committed: True/False, indicates if an item has been successfully committed.

 l ParentInRequest: True/False, indicates if the Parent is included in the request.
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Item Detail and Item Buttons
Enter or review properties for the item. Properties displayed here are set on the associated view.

 l Approvers: Add approvers to the current item.

 l Note: Enter a note for the current item.

 l Recalculate: Recalculates or refreshes the values for any calculated properties assigned 
to the view.

 l Validate: Runs validations assigned to the current item.

 l Save: Saves the current item properties.

Request Activity
View a running log of the current request activity. Click Add Comment to include additional 
commentary for the request.
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Reports
Reports display in grid or PDF view.

 l Bridge Metadata Report: Displays all metadata changes made and the requester, action 
and status in Application Control Manager.

 l Request Audit: Displays all requests made in a specified time.

 l Request Audit by Request Type: Displays the audit report specified by request type.

 l Request Audit by Status: Displays the audit report by status.

 l Request Audit by Step Type: Displays the audit report by step type.

 l Automated Request Audit with Item Detail: Displays all requests that were automated 
from a source system into Application Control Manager.

 l Request Activity Audit: Displays all activity that has happened in a specified audit time.

See:

 l "Export Report Data" below.

 l "Create Custom Reports" on the next page.

Export Report Data
To export the data, right click anywhere on the table, select Export and then select the format for 
export:

 l Excel XML

 l CSV

 l Text

 l HTML
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Create Custom Reports
You can add custom reports using combinations of business rules, dashboard data adapters, 
dashboard components, and dashboards.

NOTE: Any custom reports that use custom components are removed when 
performing an Uninstall UI.

Follow the sample steps below to add a new custom report to show the values of the custom 
properties FlowReason and FlowPriority.

 1. Add the report definition to the ACM_Reports Dashboard Data Set business rule.

NOTE: The ACM_Reports business rule is overwritten during an upgrade. 
Any customizations to this business rule must be backed up and merged into 
the updated business rule.

 2. Add the report to the list of reports. Be sure to add the comma to the previous line.

 3. Copy and paste rows 107-112 and update for the new report name.
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 4. Insert the following code after line 331:

Private Function GetMyCustomReport1(ByVal si As SessionInfo, ByVal startTime As String, 
ByVal endTime As String) As DataTable
    Try 
        Using dbConnFW As DbConnInfo = BRApi.Database.CreateFrameworkDbConnInfo(si)
            Using dbConnApp As DbConnInfo = BRApi.Database.CreateApplicationDbConnInfo(si)
 
                startTime = startTime.Replace("/", "-") & " 00:00:00"
                endTime = endTime.Replace("/", "-") & " 23:59:59"
                
                'Create the data table to return
                Dim sql As New Text.StringBuilder
                
                sql.Append("Select r.ID, r.RequesterID, r.Status, ")
                sql.Append("'Commit' As StepType, f.Label, r.LastModified, ")
                sql.Append("'" & startTime & "' As CriteriaStartTime, ")
                sql.Append("'" & endTime & "' As CriteriaEndTime, ")
                'For item level properties, use i.ItemProperties instead of r.RequestProperties
                sql.Append("JSON_Value(r.RequestProperties, '$.Properties.FlowReason') As 
FlowReason, ")
                sql.Append("JSON_Value(r.RequestProperties, '$.Properties.FlowPriority') As 
FlowPriority ")
                'FOR ITEM LEVEL PROPERTIES, UNCOMMENT NEXT 2 LINES
                'sql.Append("From " & m_ItemView & " i ")
                'sql.Append("RIGHT Join " & m_MasterRequestView & " r On i.FKRequestID = r.RequestID 
")
                sql.Append("From " & m_MasterRequestView & " r ")
                sql.Append("INNER JOIN " & m_StepTable & " s ON r.FKStepID = s.StepID ")
                sql.Append("INNER JOIN " & m_FlowTable & " f ON r.FKFlowID = f.FlowID ")
                sql.Append("WHERE s.StepType = 3 AND r.Status = 'Completed' AND ")
                sql.Append("r.LastModified >= '" & startTime & "' And r.LastModified <= '" & endTime 
& "' ")
                sql.Append("ORDER BY r.LastModified DESC")
     
                Using dt As DataTable = BRApi.Database.ExecuteSql(dbConnApp, sql.ToString, False)
                    dt.TableName = "MyCustomReport1"
                    Return dt
                End Using
                
            End Using
        End Using
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    Catch ex As Exception
        Throw ErrorHandler.LogWrite(si, New XFException(si, ex))
    End Try
 
End Function

This is what it will look like in the business rule:

5. Compile the business rule to check the syntax.

Add Reports to the Application Control Manager 
Custom Dashboard
Add the reports to the Application Control Manager Custom dashboard as follows:
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 1. Click Application Dashboards > Dashboard Maintenance Units > Data Adapters.

 2. Click Create Data Adapter.

 3. Enter a name for the data adapter.

 4. For Command Type select Method.

 5. For Method Type select Business Rule.

 6. For Method Query, click the ellipsis and add the following:

{ACM_Reports}{MyCustomReport1}{StartTime=|!Report_StartDateTime_ACM!|, 
EndTime=|!Report_zEndDateTime_ACM!|}

 7. In Results Table Name enter MyCustomReport1.

 8. Click Test Data Adapter to test the adapter.
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You should see similar results to this:

Creating a Grid View Component
Perform the following steps to create a Grid View component.
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 1. Select Components and click Create Dashboard Component.

 2. Scroll to select Grid View.

 3. Input a Name and Description for the Grid View. Prefix components, using, in this case, 
“gv_” for Grid View. Click OK.
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 4. Click  Data Adapters , the + icon, MyCustomReport1 Data Adapter, then OK.

 5. Navigate to and expand Dashboard Groups.

 6. Select Custom Reports and click Create Dashboard .

 7. Click Save.

 8. Click Add Dashboard Component.

 9. Select gv_MyCustomReport1.

 10. Click OK, then Save.
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 11. Test the dashboard by clicking View Dashboard.

A successful dashboard test would look like this:

Complete the Configuration
Once your dashboard tests successfully, finish the configuration in Application Control Manager.

 1. Return to the Application Control Manager dashboard.

 2. Click Administration.

 3. Click Reports.

 4. Add a new Report Set by clicking +.
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 5. Name the Report Set, give it a Description, and assign a Sort Order (this is for display 
order).

 6. Click Save.

 7. Highlight the MyCustomReports row in the Report Sets table.

 8. Click + in the MyCustomReports table.

 9. Fill out the information, selecting the dashboard you created from the drop-down in the 
Dashboard Name field.

 10. Click the table Save button.

 11. Navigate to Reports.

 12. Change the drop-down from Default Report Set to Custom Report Set.

 13. Select the Flow Details report set.

 14. View the report.

Administration
On the Administration page you can define controlled governance:

 l Metadata: Set up dimensions, actions, and imports.

 l Security: Enable and disable allowed security actions.

Application Control Manager Guide 24

Application Control Manager Dashboard



 l Properties: Works with OneStream-defined properties and custom properties.

 l Validations: Business rules can be set up to ensure user entry is appropriate.

 l Views: Create and edit views. Assign properties and validations to views.

 l Flows: Create the steps in the request approval process.

 l Reports: Create custom report sets.

 l Exports: Create and copy export groups and files.

 l Logs: View log details.

Metadata
Provides options for the metadata governance set up of Application Control Manager. There are 
three tabs for metadata information:

 l Dimensions

 l Actions

 l Source System Imports

Dimensions Tab
Use this tab to manually define the dimensions that you want to be able to update in a request.
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 l Label: Unique label for the dimension. Click  to add a new dimension.    

 l Cube: Cubes in the current OneStream application.

 l Dimension: OneStream dimension types.

 l DimName: OneStream dimension names.

 l MemberFilter: Text input field to assign the default member filter associated with this 
dimension.

 l Grouped: Default is False. Set to True to create a Grouped Dimension type. If enabled, 
when a new item is created, an item is created for each dimension defined in the 
GroupedDim property. The “Grouped” dimension is not a true OneStream dimension and is 
not committed to the Metadata Dimension Library.

 l GroupDim: A comma-separated list of the dimension labels that you want to group 
together.

Actions Tab
Use this tab to enable or disable actions.

 l Name: Unique name for the action in Application Control Manager. These actions are not 
editable and do not allow additions.    

 l Label: Display name of the action in Application Control Manager.

 l Request Type: The type of request that uses the action in Application Control Manager.

 l Enabled: Enable or disable actions for your Application Control Manager design.
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Source System Import Tab
Use this tab to manage source import options of Application Control Manager.

 l Process: Launches the data management step selected in the table.

 l Truncate: Truncates the member and tree tables for the selected dimension.

Retain Source System Order
The Source System Import sort order allows new members and existing members to import the 
custom order defined in the source system. Retain Source System Order must be checked for the 
source system sort order to be maintained.

 1. Go to Application Control Manager > Administration > Metadata > Source System 
Import.
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 2. Check Retain Source System Order

Retain Source System import does the following:

 l Imports a staging table and specifies a sort order.

 l Generates a request if the sort order is changed on import.

 l Commits sort order changes into the correct order as specified by the import template.

Security
Provides options for the security governance set up of Application Control Manager. You can 
manage the settings for security-type requests on the Actions tab. 

NOTE: You cannot add additional actions.

Application Control Manager Guide 28

Application Control Manager Dashboard



 l Name: Unique name for the action.

 l Label: Display name for the action.

 l Enabled: Enable or disable the action.

Properties
Properties are values that you want a user to be able to update. There are two types of properties:

 l OneStream defined properties, such as any of the built-in metadata properties.

 l Custom properties, which you can create to hold additional information

Properties can be assigned to property categories to better organize common properties or 
dimension-specific properties into groups.

Properties are attached to views.

Properties Tab

Flow Type: Specifies the type of flow this property belongs to. Available options are: Metadata, 
Security, and Generic.

Property Name: Unique property name. Click  to add a new property.

Label: Descriptive label to be used across the solution.
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Flow Property: Indicates if the property can be assigned at the flow level.

Component Type: List of dashboard components you can assign to a view. These are the same 
as the default OneStream components:

 l Check Box

 l Combo Box

 l List Box

 l Member Selector

 l Text Box

These are custom components leveraging OneStream components, but provide specific 
functionality for Application Control Manager:

 l Parent Member Selector: Member selector specifically for a Parent property, to 
distinguish from a default Member Selector for other properties.

 l Security Group Selector: Member selector that pulls from OneStream security groups.

 l Alternate Hierarchy: Member selector that creates a copy of the current item and creates 
the new member in an alternate hierarchy

Parameter Type: The type of parameter attached to the component:

 l Literal Value

 l Input Value

 l Delimited List

 l Bound List

 l Member List

 l Member Dialog

Parameter Name: If necessary, select an existing parameter to populate choices in the delimited 
list, bound list, and so on.

Namespace: Indicates if the property is built in OneStream or is custom.

Default Value: Sets the default value for the property. The default value is blank.
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Property Options: Optional. Name-value pairs used to override default settings throughout the 
solution. Property option values can be strings or parameters in the OneStream format, for 
example, |!ParameterName!|.

 l IsName: Indicates that this property is a Name property. Used for Custom Name properties.

 l IsDesc: Indicates that this property is a Description property. Used for Custom Description 
properties.

 l IsRef: Indicates that this is a Reference member.

 l IsParentName: Indicates that this property is a Parent Name. Used for Custom Parent 
properties.

 l PropName: Used for custom properties. Set the OneStream property this should update.

 l DimTypeName: Overrides the default DimTypeName on Member Selector type 
components

 l Dimension: Overrides the default Dimension on Member Selector type components

 l MemberFilter: Overrides the default MemberFilter on Member Selector type components

 l CubeName: Overrides the default CubeName on Member Selector type components

 l Tooltip: Sets the tooltip on the component

Varying Properties
The varying Properties listed under the following categories can be added or modified using user-
initiated metadata request or source system request:

 l Vary by Cube Type

 l Vary by Scenario Type

 l Vary by Scenario Type and Time

The varying properties are differentiated by the following types:
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 l Account

 o Member Properties

Relationship Properties

 l Entity

 o Member Properties

Relationship Properties

 l UDs

 o Member Properties

 o Relationship Properties

Non-varying Properties
The Non-varying Properties listed below can be added or modified using user-initiated metadata 
request or source system import:

 l Entity

 o Position Within Parent

 o Position

 o Sibling Member

 o Default Parent

 o Parent Sort Order

 l Account and UDs

 o Position within Parent

 o Aggregation

 o Aggregation Weight
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Categories Tab
Property categories are used to organize similar properties or dimension-specific properties into 
groups. Category groups are listed on the left. The properties assigned to the group are on the 
right.

These property categories display when adding properties to views.

Lists Tab
On the Lists tab, you can create name-value pairs list to be used as references in properties.  An 
example of how you might use a property list would be for a drop-down list in a property.

Click Create to create a new list.
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 l Display: Display text that a user sees when interacting with the list.  Click  to add a new 
list member.

 l Value: Value is used by the system when making changes.

Request Table and Item Table Tabs
The Request Table and Item Table tabs are system-generated and cannot be updated by the 
administrator.

Validations
Validations are business rules that run to check that user input follows specific rules.

Name: Unique validation name.

Label: Description of validation.

Failure Message: Message that displays when the validation fails.

Class: All validations are set to script.

Parameters: The business rule and associated parameters needed to run the validation script.

Validation Business Rules
To run properly, all validation scripts should be created in the ACM_Validations business rule.
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Views
A view is what you want a user to see at an Application Control Manager step. Properties and 
validations are assigned to views and then the view is assigned to a flow step.

Views Tab
Click New and Edit to create and edit views.
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Name: Unique view name.

Label: Description of view. It's helpful to include dimension, step, and action.

Request Type: This is selected from a list after view creation. Available types are: Metadata, 
Security, and Generic.

View Editor
To get into a view, select a view and then click Edit.

Properties Tab: Consists of two lists: Available Properties and Assigned Properties.
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The Filter drop-down list allows you to switch between property categories to quickly see which 
properties are available to assign to the view.

Use the center arrow buttons to add or remove the currently selected property or all properties to 
or from the assigned properties list.

Use the Assigned Properties toolbar to:

 l : Move the selected property up in the display order.

 l : Move the selected property down in the display order.

 l : Toggle the editable property for all assigned properties.

 l : Toggle the required property for all assigned properties.

 l : Toggle the calculate property for all assigned properties.

 l : Open a window to select an existing view from which to copy all properties .
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After you assign the property to the view, configure the following settings:

 l Display Order: Order property displays on the view.

 l Editable: Indicates if the property can be edited.

 l Required: Indicates if the property is required. If True, it will not pass validation if left blank.

 l Calculated: Indicates if the property is calculated based on another property.

 l Custom Label: Overrides the property label.

 l Options: Name Value pairs that are used for solution functionality.

 o Tooltip: Overrides the property tooltip.

 o UseRef: Use the property values from the Reference member assigned in the view.

 o DimTypeName: Override the DimTypeName for the property.

 l Validations Tab: Assign validations to views.

To assign validations to views:
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 1. Use the arrows to assign validations to the view. 

 2. Do one of the following:

 l Select an assigned validation and then click  to assign the validation to one or 
more properties. 

 l Click  to copy validations from another view.
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 a. Select the view to copy from and then click Copy Validations.

Flows
Flows represent the entire request approval process that a user completes when creating a 
request. Click New and Edit to create and edit flows.

Flow Editor
Summary: Properties associated with the flow.
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 l Order: The order the request type displays in the drop-down list when a user creates a new 
request.

 l Name: Unique request flow name.

 l Label: Descriptive label that users see for the request type.

 l Enabled: Determines if the request type is visible in the new request drop-down list.

 l Use Tabs?: Determines if the flow is using multiple tab views.

 l Category: Available options are: Metadata, Capital, Security, and Generic.

 l Multiple Items?: Determines if the request allows more than one item in the request.

 l Modify Approvers?: Determines if the user is allowed to select the approver from a drop-
down list of approver users.

 l Security Group: Indicates who can initiate these types of requests.

 l Error Template: Email template sent out for errors at the flow level.

 l Error Email: Email group that receives flow error emails.

 l Edit: Allows you to add a flow property to the flow level.

 l Save: Save updates to these properties.

Steps Tab

These are the steps in the approval process.
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 l Order: Step order. The Initiate step will always be the first step and the Commit step is 
always the last step for metadata requests. When creating flows on the Steps tab, the step 
order must be in sequential order and cannot be duplicated. Validations are present to 
ensure the step order and duplication are identified.

 l Step Type: Built-in step types.

 l Label: Unique label for flow-step combination.

 l Security Group: Specify which group of users has access at each step.

 l Notify: Select who gets notified on this step. ** Not currently implemented, only notifies 
email address defined.

 o None, Assignees, Participants, Assignees and Participants

 l Email Template: Select the email template to use for notification.

 l Email Address: Email group to be notified when the request is at the current step.

Options Tab

For Metadata request types, assign the dimensions to work with on this request type and then 
assign the actions to perform for each dimension.
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Assign Actions

Views Tab

The Views tab allows administrators to assign the previously created views to each individual 
step- dimension-action in the flow process. The list is automatically created when you add a new 
step or option. You must select the Assigned View from the drop-down list. To edit an assigned 
view, select the view step and then click Edit. 
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NOTE: If the View Assignment list looks incorrect or does not seem to be updated, 
click Refreshto manually refresh the list.

Create Dynamic Dashboard for Flow Views
After you create the flow and assign the views to each flow step, you must run a process to create 
the dashboard components. Go back to the main Flows screen:

 l New: Create a new flow.

 l Edit: Edit a flow.

 l Copy: Copy a flow.

 l Create: Create dynamic views for the selected flow.

 l Create All: Create dynamic views for all flow.

 l Delete All: Delete the selected row.

 l Export: Export flows to a .CSV file for review in Excel or another text editor.

The dynamic dashboards are created in a specific Dashboard Maintenance Unit named 
Application Control Manager Dynamic Dashboards (ACM). The dashboards can be reviewed 
here.
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IMPORTANT: Do not make updates to the Dashboard here because any changes are 
overwritten when the Create process runs. Only make updates using the View Editor.

Reports (Administrator)
The Reports page allows you to set up report sets for the Application Control Manager Reporting 

page. Click  to access the Reporting page.

Report Sets
Use to group Application Control Manager reports into report sets. 

 l : Add a new report set.

 l  : Delete selected report set.

 l  : Undo unsaved change.

 l  : Save changes to the report sets.

The workspace has three main columns:
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 l Name (Key): Unique name for the report set.

 l Description: More detailed description of the report set.

 l Display Order: Arrange your report sets into numerical order.

Reports
When you click on a report set, the lower pane opens where you can add the reports to the set.

 l  : Add a report to the set.

 l  : Delete selected report from set.

 l  : Undo unsaved change.

 l  : Save changes to the report.

The dashboard has six columns:

 l Name(Key): Unique name for the report.

 l Display Name: The name of the report displayed to the end user.

 l Enabled: Determines if the report in the set can be seen by the end user.

 l Display Order: Arranges reports in numerical order.
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 l Security Group: Assigns the OneStream security group that can view this report.

 l Dashboard Name: Name of the report dashboard in Application Control Manager.

The reports dashboard groups are in Application > Presentation > Dashboards > Application 
Control Manager (ACM).

There are reports that come with Application Control Manager and are listed under Default 
Reports.

Exports
On the Exports page, you can create and copy export groups and files.
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Logs
Application Control Manager has detailed logging where administrators can view all of the 
processing events including errors that have occurred in the solution.

Click Refresh to refresh the detailed logging screen. Click Delete to clear all Application Control 
Manager log files.

 l MessageTime: Timestamp for the activity

 l LogLevel: Captures the type of Log item that was written (i.e. Information, Warning, Error, 
or Fatal)

 l Category: System Category that generated that Log Entry

 l BusinessRule: Business Rule responsible for writing the Log Entry

 l Log Message: Description of the activity

 l UserName: Login name of the user who perform the activity

 l ErrorCode: Reserved for Custom Error codes.

 l ExceptionTrace: Error’s stacktrace.
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Settings
The Settings dashboard contains global solution configuration settings including initial setup, 
uninstall, and custom database table administration.

Global Setup

Global Options
Global configuration options apply to the entire solution.

 l Time Offset: Use to adjust the server time to the current time zone. This is the time stamp 
used on all activities in the solution. The value is the number of hours to adjust and can be a 
positive or negative number.

 l Detailed Logging: Enable the Logs Administration Screen item. Otherwise, only the 
OneStream system logging is used.

 l Grouped Dims: Enabled when one request needs to be applied to multiple dimensions.

After Grouped Dims is enabled, the Grouped Dim column is visible on the Dimensions tab on the 
Metadata page under Admin.

Then the admin can enter multiple dimensions in the Grouped Dim columns. If there is a Grouped 
Dim assigned to a Flow, there will be one item created at initiation for the Grouped Dim that the 
user can enter data into. After the Request is moved to the next step, there are items created for 
each of the dimensions that make up the Grouped Dim. The Enricher or Approver will see two or 
more items that match up with that grouped dimension.
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Global Security
The global security tab is where you can assign security on who can manage Application Control 
Manager.

 l Admin Security Group: Select the OneStream security group that will be the Application 
Control Manager Administrator.

Email Settings
Email settings allow you set up the email account used to send notifications from Application 
Control Manager.

 l Server Config Name: Uses the email connection defined on the OneStream server. Or you 
can set up a manual connection by filling in this information:

 o Email server: Email service address

 o Email Port: Port used by the email server settings

 o From Address: Email address which the messages should come from.
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 o Username: Email username for the account

 o Password: Password for email account

Email Templates
Templates that are used for email notifications. You can use placeholders in the subject and 
message of the email message.

Email Placeholder Options

 l FlowName

 l FlowType

 l FlowLabel

 l FlowStepLabel

 l FlowStepType

 l Message

 l Priority

 l PriorFlowStepLabel

 l RequestID

 l Requester

 l RequestStatus
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 l RequestReason

 l RequestNextAction

 Environments
Administrators can set up multiple environments to move metadata across environments.

Load/Extract
This screen allows you to load and extract components or the entire Application Control Manager 
user interface.

Extract
Use to extract the configuration and components of Application Control Manager.

 l Select Config Data to Export: Select the specific configuration piece that you want to 
extract to a flat file for future import or backup.

 l Extract All Config Data: Extracts all pieces of Application Control Manager configuration 
to a flat file for future import or backup.

 l Extract App Components: Extracts all solution components to a .zip file for backup or 
import.
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Load
Use to delete and load the Application Control Manager configuration and components.

 l Delete Config Data: Clears all current Application Control Manager configuration 
data. Use this before importing new configuration data from file.

 l Load Data: Imports configuration data from file.

Other
Use to extract the entire Application Control Manager user interface.

Uninstall
 1. In the Application Control Manager Dashboard, click  and then, under Settings, click 

Uninstall.

 2. Select an option:

 l Uninstall UI to remove the dashboards, business rules and keep all the data in the 
database tables. This is useful for updates to the solution.

 l Uninstall Full to completely uninstall the solution including all components and data. 
This drops the custom database tables and removes all dashboards. You can’t 
recover from this unless you have backed up both the dashboards and data.
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Administration Tasks
Create a New Flow
To create a new flow for a request type:

 1. In the Application Control Manager Admin Dashboard, navigate to Views.

 2. Create a view for each step that will be in the request flow.

 a. Assign the properties to the view.

 b. Assign the validations to the view.

 3. Navigate to Flows.

 4. Create a new flow and save it before adding steps, options, and views.

 5. On the Steps tab, add the steps for your approval workflow.

 6. On the Options tab, assign the Dimension-Actions combination that you want to be 
available for this flow.

 7. After all steps and options are added, on the Views tab, select the Assigned View for each 
Step – Option combination.

 8. Make sure the flow is enabled to make it available in the New Request drop-down list.

 9. Save the flow and close the Flow Editor.

 10. Run the Create Flow Views process.

Refreshing Dynamic View Dashboards
 1. Make the necessary changes to the view or flow that you want to update. Changes can be 

updating a label, adding or removing a property, changing the order of the properties, 
adding or removing steps in a flow.

 2. Go to Administration> Flows.
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 3. Select the flow that you changed.

 4. Click Create. 

TIP: If you want to refresh all dynamic dashboards, click Create All.

Metadata Import
Setup Data Sources
When Application Control Manager is installed, a default set of data connectors is installed. There 
is one connector for each supported dimension:

These data sources are set up to connect to staging tables which are created during the 
Application Control Manager installation process. These staging tables are named with the 
following format: ACM_Metadata<dimension>ImportTree and ACM_
Metadata<dimension>ImportMembers.
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The tables with "Members" in the name store the unique list of members from the source 
metadata system. Each dimension table has a different set of properties that you can import into 
OneStream but the Member field must always be populated:

The tables with "Tree" in the name store the overall hierarchy details. Each table contains four 
columns.

The Dimension column must be populated with the name of the Application Control Manager 
dimension that you are loading. This is set up in the Application Control Manager Administration 
screen:
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The Parent and Child columns are populated with member names found in the Member column of 
the associated Members table. SortOrder can be used to sort the hierarchy. If order is not 
important, enter a value of 1 for all rows in the hierarchy table.

Workflow Profiles
When Application Control Manager is installed, a Workflow Profile named ACM_MetadataImport_
Default is automatically created in your system.  In addition, a special cube is created:  ACM_
MetadataImport. 

By default, the data source name for each dimension is set to utilize the data connectors 
mentioned in the prior step. 
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Select the transformation profile named ACM_ImportMetadata. This is automatically created in 
your environment when Application Control Manager is installed.

The Workflow Profiles are used to import the metadata loaded in the staging tables into the 
OneStream staging tables. After the information is loaded, the metadata is analyzed to determine 
differences that exist between the source data and the metadata stored in OneStream. The 
system looks for differences in this order:

 1. Missing members in the metadata as compared to the source system

 2. Existing members that need to be migrated or copied to a different hierarchy

 3. Updates to existing member properties.

If Application Control Manager finds any updates it builds a request in the system. The results of 
this process are displayed on the main home page of Application Control Manager.

Global POV Time
When running a source system import, the system loads the data in the current year and month 
staging tables, and the Global Time is set to a full year.

If the application is configured with “Enforce Global POV” set to TRUE, the load process uses the 
value that the Global POV is set to. If the Global POV is set to a date format other than YYYYMM, 
an error occurs because the OneStream Software workflow profile will not load properly.
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If “Enforce Global POV” is set to FALSE, the data management source system import process 
ignores any Global POV settings and instead uses the system date and time to determine the 
period for loading data.

Metadata Import Fields
To map the import data to the metadata properties in OneStream, go to the Application Control 
Manager Administration screen and select Views. A single view for each workflow profile is 
created when Application Control Manager is installed. Select the one you want to modify and 
then click the Edit button:

On the right side of the dialog, you can see the list of metadata properties that map to the columns 
in the database:
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These match the information in the database:
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If you want to change the list of properties monitored and updated in OneStream, use the arrow 
buttons to move fields in and out of the list. If you do this, you must modify the related Connector 
Business Rule:
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In the business rules, find the GetFieldList method and associated method containing the SQL to 
pull information from the database in GetSourceDataSQL. Make sure the fields match the order 
that Application Control Manager has in the associated view.

Data Management Groups
The process of loading and committing metadata updates to OneStream is handled using Data 
Management steps and sequences. 
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The data management steps are preconfigured when Application Control Manager is installed.  
The Load items are set up to execute the workflow profile associated with the dimension name. 
The process loads the data from the database into the OneStream staging tables, performs the 
comparison process, and builds a request if necessary.

The associated Workflow Profile is in the parameters on the data management step:

 l WorkflowProfileName:  Specify the name of the dimension you are importing for.  This 
matches the Workflow Profile as well as the WF Profile Name in the Metadata Import Fields 
screen.

Ensure the business rule is set to ACM_MetadataImport.

The execution of the steps Load <…> perform the following steps:
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 1. Loads the data from the database or file into the workflow for the current global POV’s time 
and scenario.

 2. Compares the data loaded into OneStream to the existing members for the selected 
dimension and determines what members need to be added.

 3. Compares the data loaded into OneStream to the existing hierarchy for the selected 
dimension and determines what updates are required to the overall hierarchy. In this step, 
updates such as adding a new parent-child relationship and creating a new sub-hierarchy 
for an existing set of members is.

 4. Compares the data loaded into OneStream to the existing members and determines what 
properties need to be modified.

 5. Compares the existing members and hierarchy in OneStream to the data loaded into the 
system to determine what members need to be removed from the hierarchy. Any member 
not in the import file/table is marked as orphaned in OneStream. The member is not 
deleted.

 6. Builds an Application Control Manager request which performs all the required operations 
in a single transaction.

After a request has been generated, the Commit All Metadata Updates data management step 
executes to commit the updates to the system.

The Data Management Steps can be combined into a sequence to allow for the full automation of 
the process using a PowerShell script and the Windows Task Scheduler on the OneStream 
application server.  You can automate the load and commit steps to include no user interaction 
before commit or you can set the system up to require an individual on the Finance team to review 
the request before manually committing it into the system.

Metadata Synchronization
Initial Setup and Configuration
The metadata migration and synchronization feature of Application Control Manager keeps the 
metadata hierarchies between two OneStream installations/environments in sync with one 
another. This is accomplished by utilizing the REST API built into OneStream. The configuration is 
completed in the destination environment. The REST API in the source environment requires 
setup on the server side so ensure that the proper configuration is in place and request the 
following details for your Azure Single Sign-On configuration from your technical support 
representative:
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 l Azure AD Tenant ID

 l OneStream Web Api Client ID

 l OneStream Web Api Client Secret Key

 l Source OneStream System URL

 l Source OneStream System Application Name

The first three values can be found in the OneStream WebServerconfig.xml:

Enter these five values for the source OneStream environment into the Application Control 
Manager Setup screen:

Start by adding a new source environment name in the left panel. This is for all environments that 
you want to synchronize metadata from and into the current environment:
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Next, add the information gathered in the prior step for the REST API details of the source system. 

In the right panel, click  to add each value.

When finished, click  and the system saves the data and automatically encrypts the values. 
They are encrypted at the database level for security purposes.

Should you need to update them in the future, copy new values over the encrypted information 
and the system re-encrypts after you save.
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Data Management Job Configuration
The metadata synchronization process is executed via a Data Management job in OneStream. 
When Application Control Manager is installed, a Data Management Group named Application 
Control Manager Metadata Migration (ACM) group containing associated steps is automatically 
created:

As with other features in Application Control Manager, there is a step associated with each of the 
dimensions in OneStream.

To complete the setup, you must update the parameters section of the step. The 
EnvironmentName parameter is entered in the initial setup step from Application Control 
Manager:

The WorkflowProfileName is always “Migration” and the FlowName matches the workflow profile 
name. These two values should not be changed.
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Execution
When any of the Load <dimension name> steps are executed the following occurs:

 l Prepare metadata on remote (source system)

 o Using the REST API that was configured in the Application Control Manager system 
administration screen, the system remotely executes a Data Management setup on 
the source system named Application Control Manager Metadata Migration (ACM) -> 
Prepare Metadata.

 o This process gathers all metadata information including the member list, hierarchy, 
and properties for the dimension specified in the workflow profile. This information is 
stored in a temporary staging table in the database.

 l Retrieve metadata from a remote system

 o Using the REST API, make a built-in API call named 
GetAdoDataSetForSqlCommand on the remote system, the system pulls the 
information and loads it into the local (destination) OneStream application’s database 
for further processing.

 l After the data is loaded into the database, the same processing that occurs during a 
metadata import takes place. If any updates are required, the system automatically 
generates a request which can be committed using the Application Control Manager 
Metadata Migration (ACM) -> Commit All Metadata Updates Data Management step.

Request Migration
Initial Setup and Configuration
Application Control Manager can migrate requests from one OneStream environment to another. 
You can use this as a testing feature to see how metadata updates will impact a production 
system before committing them in that environment. You can also use it to keep two systems 
synchronized with each other.

Before continuing, follow the setup steps outlined in the Metadata Synchronization section above. 
You must set up a destination environment where requests will be sent.
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Add a new step to any flow you have configured in the system. In the Application Control Manager 
administration screen, select Flows and edit or create a flow to use for the migration. Add a new 
step to the flow after the Initiate step and select “Migrate”.

Click Edit:

Specify the destination system where you want to commit the request. This was defined in the 
prior configuration step.

Select the target environment:
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When you create a new request in the system and advance from the initiate step you will see the 
system report the next step to be “migrate”:

When you manage this request and advance to the next step, the system automatically connects 
to the target environment’s REST API and pushes the request information from the source system 
to the destination environment and automatically commits the request. After reviewing and testing 
in that environment, return to the source system and continue processing as you normally would.
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Help & Miscellaneous Information
This page contains solution documentation.

Display Settings
OneStream and MarketPlace solutions frequently require the display of multiple data elements for 
proper data entry and analysis. Therefore, the recommended screen resolution is a minimum of 
1920 x 1080 for optimal rendering of forms and reports.

Additionally, OneStream recommends that you adjust the Windows System Display text setting to 
100% and do not apply any Custom Scaling options.

Package Contents & Naming Conventions
The package file name contains multiple identifiers that correspond with the platform. Renaming 
any of the elements contained in a package is discouraged in order to preserve the integrity of the 
naming conventions.

Example Package Name: ACM_PV6.3.0_SV201_PackageContents.zip         

Identifier Description

ACM Solution ID

PV6.3.0 Minimum Platform version required to run solution

SV201 Solution version

PackageContents File name
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Solution Database Migration Advice
A development OneStream application is the safest method for building out a solution with custom 
tables such as this one. The relationship between OneStream objects such as workflow profiles 
and custom solution tables is that they point to the underlying identifier numbers and not the 
object names as seen in the user interface. Prior to the solution configuration and to ensure the 
identifiers match within the development and production applications, the development 
application should be a recent copy of the production application. Once the development 
application is created, install the solution and begin design. The following process below will help 
migrate the solution tables properly.

See also: Managing a OneStream Environment in the Design and Reference Guide.

 1. In the production OneStream application, install the solution and create the data tables. 
See "Configure the OneStream Application Server" on page 3 for Database Server 
Connection settings and installation details.

 2. Data tables are created in the OneStream Development application during the solution 
installation. Using the Microsoft Data Migration Assistant, copy the data from the tables to 
the Production Microsoft SQL Server Database. Only the Microsoft SQL Administrator 
should run the migration assistant.

IMPORTANT: This process has the potential to overwrite existing table data in the 
production application database if data already exists.

MarketPlace Solution Modification 
Considerations
A few cautions and considerations regarding the modification of MarketPlace solutions:

 l Major changes to business rules or custom tables within a MarketPlace solution will not be 
supported through normal channels as the resulting solution is significantly different from 
the core solution.
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 l If changes are made to any dashboard object or business rule, consider renaming it or 
copying it to a new object first. This is important because if there is an upgrade to the 
MarketPlace solution in the future and the customer applies the upgrade, this will overlay 
and wipe out the changes. This also applies when updating any of the standard reports and 
dashboards.

 l If modifications are made to a MarketPlace solution, upgrading to later versions will be more 
complex depending on the degree of customization. Simple changes such as changing a 
logo or colors on a dashboard do not impact upgrades significantly. Making changes to the 
custom database tables and business rules, which should be avoided, will make an 
upgrade even more complicated.
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